Outline: Statistical Analysis for
Psychological Testing
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Entering Data
1) Set up the structure of the data file by ‘defining’ the variables
2) Enter the data

Defining the Variables
1) In Data Editor Window, changing from Data View to Variable View
2) Defining each of your variables by specifying the required information for each variable

a. Name
b. Type (Numeric/String)
c. Width
d. Decimals
e. Label
f.  Values
i. Value
ii. Value Label
iii. Add/Remove/Change
g. Missing

i. No missing values

ii. Discrete missing values

iii. Range plus one optional discrete missing value
h. Columns
i. Align (Right/Left/Center)
j. Measure (Nominal/Ordinal/Scale)

3) Shortcut in defining variables

a. Copy and paste
b. Paste Variables...

Entering Data
1) Go to Data View

2) Typeinthe data

3) Press Right arrow or Tab on the keyboard

4) Make sure that the values are entered in the correct columns

5) Move back to the first column by press Tab or Home or Ctrl + left arrow



Move an existing variable
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Right click where you would like the moved variable to appear

Choose Insert Variable

An empty column, named “Var00001”, will appear in which you can enter the new variable.
Right click on the variable name of the existing variable you wish to move.

Choose Cut

Right click on the empty variable, the destination, and choose Paste.

Modifying the data file

Sort cases

Method 1
1)
2)

Method 2
1)
2)

Split File

Right click on the variable you want to sort its values.
Choose Sort Ascending (from least to most) or Sort Descending (from most to least)

Data > Sort Cases...

Choose Ascending or Descending in Sort Order depend on the direction you want to sort in
the first variable

Choose the first variable in Sort by blank.

If you want to sort second variable within the equal values in first variable, choose Sort
Order and then the second variable.

For example, select sex (Ascending) and then age ascending

Sex Age
30
25
29
21
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To split your file

1)
2)

Data - Split File...

Click on “Compare Groups” or “Organize output by groups” (depending on table format you
want to see) and specify the grouping variable

Click on OK

You will see “Split File on” on the right bottom on the window.



To turn the Split File off
1) Data > Split File...
2) Click on the first dot (Analyze all cases, do not create groups)
3) Click on OK
4) You will see “Split File on” disappear from the screen.

Select Cases

To Select Cases
1) Data > Select Cases...
2) Click on If conditions is satisfied
3) Click on the button labeled IF...

4) Choose the variable that defines the group that you are interested in

5) Click on the arrow button to move the variable name into the box

6) Type in the value that corresponds to the group you are interested in

7) Click on Continue, you will see your selected group on the right of IF... box

8) Click on OK

9) You will see “Filter on” on the right bottom of the window and the new variable, named
filter S

To turn the select cases option off
1) Data = Select Cases...

2) Click on the first dot (All cases)

3) Click on OK

4) You will see “Filter on” disappeared from the screen
5) Delete filter_S from variable lists

Cleaning the Data

Checking for errors

There are many ways to check for errors. Each method is suitable for different kinds of variables.
This method | show you is suitable for categorical and numerical variables, not for multiple response
sets, set of variables that show respondent’s alternative.

1) Analyze - Descriptive Statistics = Frequencies
2) Choose the variables that you wish to check (You can use Ctrl or Shift to help in selecting
multiple variables)
) Click on the arrow button to move these into Variables box
) Ensure to check on Display frequency tables
5) Click on OK
) SPSS will show you the Statistics Table and Frequency tables of each selected variables in
the SPSS Output Viewer



a. Statistics Table will summarize each of the variables you requested
b. Frequency tables of each variable will range your responses

7) Ineach variable, check on impossible value and system missing

8) Go on next step, finding the error in the data file

Finding and Correcting the Error in the Data File

Method 1

1) Highlight the variable name of the variable in which the error has occurred

2) Edit > Findor Ctrl+F

3) Inthe Search for box, type in the incorrect value that you are looking for

4) Click on Search Forward box

5) Take note of the ID number of this case and then find out the correct value in the
questionnaire.

6) Click on Search Forward to continue searching for other cases with the same incorrect value
and find out the correct value to replace

Method 2

1) Sort cases with Method 1 in variable in which the error has occurred

2) If you sort ascending, the system missing will appear on the first rows.

3) Take note of the ID number of this case and then find out the correct value in the
questionnaire.

4) Find out incorrect value that you are looking for, if they find out easily by sort ascending or
sort descending.

5) Take note of the ID number of this case and then find out the correct value in the
questionnaire.

Rechecking for Errors
After you have corrected your errors, it is a good idea to repeat Frequencies... to double-check.
Sometimes in correcting one error, you may have accidentally caused another error.

Descriptive Statistics

Graphical Illustration
There are many ways to build graph. This procedure is the most sophisticated way to build
graph.



Building Graph

1) Graph = Chart Builder...

2) There are two adjacent windows: Chart Builder and Element Properties (If the Element
Properties window does not appear, click the Element Properties button on the bottom left
of Chart Builder window)

3) Choose the graphical illustration that you want to present your data in the bottom of Chart
Builder Window.

4) Drag variables you want to represent each component of the graph from Variable box to
Destination

5) Edit each element in the graph by click on element in Edit Properties of box in Element
Properties window

6) Change this element properties under Edit Properties Box (such as each axis label)

7) Click on OK

Edit Graph
1) Right click on graph that you want to edit
2) SPSS Chart Object = Open

Numerical Illustration

Numerical Illustration for one variable

Percentage for each category in categorical variable

1)
2)
3)
4)

Analyze - Descriptive Statistics 2 Frequencies...

Choose the variables that you wish to find out percentage of each category
Click on the arrow button to move these into Variables box

Click on OK

Mean, Median, Mode, SD, Minimum, Maximum, Sum
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Analyze = Descriptive Statistics = Descriptive...

Choose the variables that you wish to find out these statistics
Click on the arrow button to move these into Variables box
Click on Options button

Choose statistics that you want to find out from these variables
Click on Continue

Click on OK

Quartile, Decide, Percentile

Analyze - Descriptive Statistics = Frequencies...

Choose the variables that you wish to find out quartiles, decides or percentiles

Click on the arrow button to move these into Variables box

Click on Statistics button

In Percentiles Values, you can choose quartiles, decides (cut point for 10 equal groups) or
specific percentiles (fill the percentiles you want and then click on Add)



6)
7)
8)

Click on Continue
Click on OK
This statistics will appear on Statistics table in SPSS Output.

Numerical Illustration for two variables

Percentage in each group

1)

Method 2
3
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Analyze = Descriptive Statistics = Crosstabs...
Suppose that you want to find percentage of drinking alcohol in each sex. You can find it out
by two alternatives

Choose Drinking Alcohol in variables list and click on arrow to Row box
Choose Sex in variables list and click on arrow to Column box

Click on Cells... button

In Percentage, click on Column

Click on Continue

Click on OK

Choose Sex in variables list and click on arrow to Row box

Choose Drinking Alcohol in variables list and click on arrow to Column box
Click on Cells... button

In Percentage, click on Row

Click on Continue

Click on OK

Mean, Median, Mode, SD, Min, Max, and Sum in each group

1)
2)

Jae 2

Analyze 2 Compare Means = Means...

Choose group variable in variables list and click on arrow to Independent List (If your
grouping variables are combined in factorial design, you can choose another group variable
to Independent List)

Choose numerical variables that you wish to find out these statistics in groups that you
defined in Independent List and click on arrow to Dependent List

Click on Options...

Choose Statistics from list and click on arrow to Cell Statistics

Click on Continue

Click on OK



Screening the Data

Normality

In screening data, there are many ways to detect deviation from normality. However, SPSS
provide the command for screening data.

1)
2)
3)
4)
5)
6)
7)
8)
9)

Analyze = Descriptive Statistics = Explore

Choose the variable that you wish to examine the distribution

Click on the arrow button to move into Dependent List box

Click on Plots...

Check Normality plots with tests

Check Stem-and-Leaf and Histogram in Descriptive box

Click on Continue

Click on OK

SPSS output show stem-and-leaf display, histogram, Normal g-q plot, Detrended normal g-q
plot, Skewness and Kurtosis in Descriptive Table, and Test of Normality Table

*Normal g-q plot is better than normal p-p plot because it is more sensitive in deviating from

normality in the tail of distribution.

*The Shapiro-Wilk Test has superior power to other statistics in detecting that the data comes
from a wide range of other distributions.

Outlier and Extreme Score
In screening data, there are many ways to detect deviation from normality.

Method 1
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9)

Analyze - Descriptive Statistics = Explore

Choose the variable that you wish to examine outlier and extreme score
Click on the arrow button to move into Dependent List box

Choose the variable that represent ID, if available

Click on the arrow button to move into Label Cases by

Click on Plots...

Choose Dependents together in Boxplots box

Click on Continue

Click on Statistics...

10) Check Outliers

11) Click on Continue

12) Click on OK

13) SPSS output show extreme values (both highest and lowest identified by ID number)
14) SPSS output also show boxplot of the variable

Method 2
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a. The circles represent outlier (outside Mdn + 2(Q; — Q;))
b. The asterisks represent extreme value (outside Mdn + 3.5(Q; — Q,))

Analyze - Descriptive Statistics = Descriptive...

Choose the variable that you wish to examine outlier and extreme score
Click on the arrow button to move into Variable box
Check “Save standardized values as variables”



5) Click on OK

6) Change window to Data Editor. You will see new variable that represent standard score of
selected variable.

7) The outlier is outside -2.5 to 2.5

Manipulating the data

Rank Cases
1) Transform = Rank Cases...

2) Choose the variable that you wish to rank
3) Click on the arrow button to move into Variable box
4) Choose Smallest value or Largest value in “Assign Rank 1 to” box

5) Click on Rank Types... button

6) Check Rank

7) Click on Continue

8) Click on Ties... button

9) Choose Mean, Low, High or Sequential ranks to unique values to customize your ranking
10) Click on Continue

11) Click on OK

12) You will see new variable that represent rank of selected variable in Data Editor Window.

Linear z-score

1) Analyze - Descriptive Statistics = Descriptive...

2) Choose the variable that you wish to examine outlier and extreme score

3) Click on the arrow button to move into Variable box

4) Check on “Save standardized values as variables”

5) Click on OK

6) Change window to Data Editor. You will see new variable that represent standard score of

selected variable.

Linearly Transforming Variable to Percentile Rank

1) Transform = Rank Cases...

2) Choose the variable that you wish to transform

3) Click on the arrow button to move into Variable box
4) Click on Rank Types... button
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Click on Continue

Click on OK

You will see new variable that represent percentiles of selected variable of each case in Data
Editor Window.
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Normalized z-score

1)
2)
3)
4)
5)
6)

7)
8)
9)

Transform = Rank Cases...

Choose the variable that you wish to transform
Click on the arrow button to move into Variable box
Click on Rank Types... button

Check “Normal scores”

In “Proportion Estimation Formula” box, choose the formula you want to use in normalizing.
The default formula is Blom’s formula.

Click on Continue

Click on OK

You will see new variable that represent normalized standard score in Data Editor Window.

Normalized Percentiles
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Transform = Rank Cases...

Choose the variable that you wish to transform
Click on the arrow button to move into Variable box
Click on Rank Types... button

Check “Proportion Estimation Formula”

In “Proportion Estimation Formula” box, choose the formula you want to use in normalizing.
The default formula is Blom’s formula.

Click on Continue

Click on OK

You will see new variable that represent normalized proportion in Data Editor Window.

10) Transform = Compute Variable...

11) Name the new variable, representing normalized percentile, in Target Variable.

12) In Numeric Expression box, type the name of normalized proportion variable and then

follow with “* 100*”

13) Click on OK
14) You will see new variable that represent normalized percentile.

Dividing Groups from Smallest to Largest
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Transform = Rank Cases...

Choose the variable that you wish to divide
Click on the arrow button to move into Variable box
Click on Rank Types... button

Check “Ntiles” and type in the number of groups you want to divide

Click on Continue

Click on OK

You will see new variable that represent grouping in Data Editor Window.



Recoding Value in each Variable
You can use Recode command to Utilize

9)

Transform = Recode into Different Variables...

Choose the variable that you wish to recode

Click on the arrow button

Name and label the new variable in Output Variable Box

Click on Change

Click on “Old and New Values...”

Define the old value you want to change in Old Value box

Define the new value you want to replace the old value in New Value box.
Click Add, then this changing will appear on “Old = New:” box.

10) Define another old value, new value, and then click Add.
11) You can Change or Remove your command, until finishing.
12) Click on Continue

13) Click on OK

14) You will see new variable appear in Data Editor

Calculating data from variables in each case

1)
2)
3)

4)
5)

T-test

Transform = Compute Variable...

Name the new variable in Target Variable.

In Numeric Expression box, type the command that you want to calculate from variable in
your list.

Click on OK

You will see new variable appear in Data Editor.

One Sample T-test

1)
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Analyze - Compare Means = One-sample T test...
Click on the tested variable

Type test value

Click on OK

Paired-Samples T-test

1)
2)

Analyze 2 Compare Means = Paired-Samples T test...

Click on the first variable you want to compare, such as pretest. Then, the clicked variable
will appear after Variable 1: in Current Selections box.

Click on the second variable you want to compare, such as posttest. Then, the clicked
variable will appear after Variable 2: in Current Selections box.

Click on the arrow button

Click on OK



Independent-Samples T-test

1) Analyze > Compare Means = Independent-Samples T test...
2) Click on the dependent variable
3) Click on the arrow button to move into Test Variables(s): box
4) Click on the independent variable
5) Click on the arrow button to move into Grouping Variables: box
6) Click on Define Groups... button
7) Type in the value of both groups you want to compare in Group 1 and Group 2 boxes.
8) Click on continue
9) Click on OK
Correlation

Pearson Product Moment Correlation and Point-biserial Correlation

1)
2)

3)
4)

Analyze - Correlate - Bivariate...

Select variables to compute correlation (if you select more than two variables, the SPSS will
provide you a correlation matrix of each pair of variables.)

Select two-tailed or one-tailed in Test of Significance box

Click on OK

Phi Coefficient

Click on OK

1) Analyze = Descriptive Statistics = Crosstabs...
2) Select the first dichotomous variable into Rows box.
3) Select the second dichotomous variable into Column box.
4) Click on Statistics... button
5) Check “Phi and Cramer’s V” in Nominal box
6) Click on Continue
7) Click on OK
Chi-square
1) Analyze - Descriptive Statistics = Crosstabs...
2) Select the first dichotomous variable into Rows box.
3) Select the second dichotomous variable into Column box.
4) Click on Statistics... button
5) Check Chi-square in the top left of window
6) Click on Continue
)



Simple Regression

1)
2)
3)
4)
5)
6)

Analyze - Regression = Linear...

Click on the dependent variable

Click on the arrow button to move into Dependent box
Click on the independent variable

Click on the arrow button to move into Independent box
Click on OK



SPSS Output

In these printouts, the variables are sex (male, female), education (high school, undergraduate),
family support, couple support, and friend support (possible minimum =5 and maximum = 20).

Descriptive Statistics: Graphical Illustration
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Histogram
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Cumulative Frequencies Distribution
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Line Graph representing Interaction
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Scatterplot with multiple type of dots
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Descriptive Statistics: Numerical Illustration
Frequencies Distribution
Statistics
sex
N Valid 119
Missing 1
sex
Cumulative
Frequency Percent Valid Percent Percent
Valid male 57 475 47.9 47.9
female 62 51.7 52.1 100.0
Total 119 99.2 100.0
Missing 99 1 8
Total 120 100.0




Descriptive

Descriptive Statistics

N Minimum Maximum Sum Mean Std. Deviation Variance
family 120 6.00 20.00 2016.00 16.8000 2.86268 8.195
couple 120 4.00 20.00 1769.16 14.7430 3.32347 11.045
Valid N (listwise) 120
Quartile, Decide, Percentile
Statistics
family
N Valid 120
Missing 0
Percentiles 10 13.0000
20 15.0000
25 15.0000
30 16.0000
40 16.0000
50 17.0000
60 18.0000
65 19.0000
70 19.0000
75 19.0000
80 20.0000
90 20.0000
Percentage in each group
Case Processing Summary
Cases
Valid Missing Total
N Percent N Percent N Percent
sex * education level 120 100.0% 0 0% 120 100.0%
sex * education level Crosstabulation
education level Total
high school undergraduate high school
sex male Count 29 29 58
% within education level 47.5% 49.2% 48.3%
female Count 32 30 62
% within education level 52.5% 50.8% 51.7%
Total Count 61 59 120
% within education level 100.0% 100.0% 100.0%




Descriptive Statistics in each group

Case Processing Summary

Cases
Included Excluded Total
N Percent N Percent N Percent
family * sex 120 100.0% 0 0% 120 100.0%
Report

family

sex Mean Std. Deviation Minimum Maximum
male 16.8621 58 2.43835 11.00 20.00
female 16.7419 62 3.22864 6.00 20.00
Total 16.8000 120 2.86268 6.00 20.00

Checking Normality

Normal P-P Plot

Normal P-P Plot of family
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Detrended Normal P-P Plot of family

T 00257 ®
£ s
o o @
Z 0.000
£
o
c -0.025+
i) °
o o
ks o
5 -0.050+
o
(o]
(o]
-0.075
T T T T T T
0.0 0.2 0.4 0.6 0.8 1.0
Observed Cum Prob
Normal Q-Q Plot
Normal Q-Q Plot of family
o
— 17
©
£
O
> 0
©
)
817
o
x
w
-2 @
o
-3
T T T T T
5 10 15 20 25

Observed Value



Detrended Normal Q-Q Plot of family

Skewness and Kurtosis
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Observed Value
Descriptives
Statistic Std. Error
family  Mean 16.8000 .26133
95% Confidence Lower Bound 16.2825
Interval for Mean Upper Bound
17.3175
5% Trimmed Mean 17.0185
Median 17.0000
Variance 8.195
Std. Deviation 2.86268
Minimum 6.00
Maximum 20.00
Range 14.00
Interquartile Range 4.00
Skewness -.949 221
Kurtosis .878 438




Kolmogorov-Smirnov Test and Shapiro-Wilk Test
Tests of Normality

Kolmogorov-Smirnov(a) ‘ Shapiro-Wilk
Statistic df Sig. Statistic df Sig.
family 137 120 .000 .906 120 .000
a Lilliefors Significance Correction
Checking Outliers and Extreme Scores
Extreme Value
Extreme Values
Case Number number Value
family  Highest 1 11 | 59 20.00
2 12 | 99 20.00
3 20 | 10 20.00
4 22 | 115 20.00
5 23 | 116 20.00(a)
Lowest 1 104 | 52 6.00
2 57 | 114 9.00
3 50 | 30 10.00
4 93 | 76 11.00
5 74 | 39 11.00(b)

a Only a partial list of cases with the value 20.00 are shown in the table of upper extremes.
b Only a partial list of cases with the value 11.00 are shown in the table of lower extremes.




Boxplot
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Inferential Statistics

One-sample T-test

T
family

One-Sample Statistics

Std. Error
N Mean Std. Deviation Mean
family 120 16.8000 2.86268 .26133
One-Sample Test
TestWalue=14
95% Confidence
Interval ofthe
Mean Difference
1 df Sin. (2-tailed) Difference Lower Upper
family f.888 1149 .0oo 1.80000 1.2825 231745




Paired-sample T-test

Paired Samples Statistics

Std. Error
Mean N Std. Deviation Mean
Pair1  family 16.8000 120 2.86268 26133
couple 14.7430 120 3.32347 .30339
Paired Samples Statistics
Std. Error
Mean N Std. Deviation Mean
Pair 1 family 16.8000 120 2.86268 26133
couple 14.7430 120 3.32347 .30339
Paired Samples Test
Faired Differences
95% Confidence
Interval of the
Std. Error Difference
tean Std. Deviation Mean Lower Upper t df Sig. (2-tailed)
Pair1  family - couple 2.08704 419622 38306 1.28854 281554 5,370 114 .oon




Independent-samples T-test
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Correlation Matrix

Correlations

family friend couple

family Pearson Correlation 1 .285(*%) .086

Sig. (2-tailed) .002 .352

N 120 120 120
friend Pearson Correlation .285(**) 1 .396(**)

Sig. (2-tailed) .002 .000

N 120 120 120
couple  Pearson Correlation .086 .396(*) 1

Sig. (2-tailed) .352 .000

N 120 120 120

** Correlation is significant at the 0.01 level (2-tailed).




Chi-Square and Phi Coefficient

Case Processing Summary

Cases
Valid Missing Total
N Percent N Percent N Percent
sex * education level 120 100.0% 0 0% 120 100.0%
sex * education level Crosstabulation
education level Total
undergrad
high school uate high school
sex male Count 29 29 58
Expected Count 295 28.5 58.0
female  Count 32 30 62
Expected Count 315 30.5 62.0
Total Count 61 59 120
Expected Count 61.0 59.0 120.0
Chi-Square Tests
Asymp. Sig. Exact Sig. | Exact Sig.
Value df (2-sided) (2-sided) (1-sided)
Pearson Chi-Square .031(b) .860
Continuity
Correction(a) 000 1.000
Likelihood Ratio .031 .860
Fisher's Exact Test 1.000 .502
Linear-by-Linear
Association 031 -860
N of Valid Cases 120

a Computed only for a 2x2 table
b 0 cells (.0%) have expected count less than 5. The minimum expected count is 28.52.

Symmetric Measures

Value Approx. Sig.
Nominal by Phi -.016 .860
Nominal Cramer's V 016 860
N of Valid Cases 120

a Not assuming the null hypothesis.

b Using the asymptotic standard error assuming the null hypothesis.




Simple Regression

Variables Entered/Removed(b)

Variables Variables
Model Entered Removed Method
1 couple(a) Enter
a All requested variables entered.
b Dependent Variable: family
Model Summary
Adjusted R | Std. Error of
Model R R Square Square the Estimate
1 .086(a) .007 -.001 2.86419
a Predictors: (Constant), couple
ANOVA(b)
Sum of
Model Squares df Mean Square F Sig.
1 Regression 7.175 1 7.175 .875 .352(a)
Residual 968.025 118 8.204
Total 975.200 119
a Predictors: (Constant), couple
b Dependent Variable: family
Coefficients(a)
Unstandardized Standardized
Coefficients Coefficients t Sig.
Model B Std. Error Beta B Std. Error
1 (Constant) 15.711 1.194 13.161 .000
couple .074 .079 .086 .935 .352

a Dependent Variable: family




